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About CBL Interactive (CBLi)

System Environment
CBL Interactive (CBLi) is a full screen 3270 application which runs in the following environments:

e Under TSO/E in MVS, OS/390 and z/OS.

e Under ISPF in MVS, OS/390 and z/OS.

¢ As a VTAM application in MVS, OS/390 and z/OS. (See Disaster Recovery below)
e As a VTAM application in VSE/ESA.

¢ Under CMS in VM/ESA and z/VM.

Disaster Recovery

CBLi has the same functionality when executing as a VTAM application as it does when running under TSO. Therefore, the
CBLIVTAM module and VTAM applid may be installed on a recovery volume to perform data editing, data set allocation and
system navigation if ISPF is unavailable.

Couple this with SELCOPY, which is usually installed in the same load library as CBLi, the systems programmer is provided with a
powerful set of tools to aid the data recovery process.

General Functionality
CBLi allows the user to generate, operate on and manipulate data within windows that may contain:

* DASD Volume lists.

¢ VTOC, Data set and member lists.

¢ Interactive SELCOPY execution.

e Interactive CBLVCAT execution.

¢ CBLe windowed text editor.

e DB2 SQL interface.

e Sequential file or VSAM object definition.

CBLi Environment
CBLi provides a full screen 3270 interface which supports the following windows style features:

e Drop down and popup menus.

¢ Resizable and movable windows.

¢ Multiple overlapped views of file and volume lists.

e Multiple overlapped Interactive SELCOPY execution windows.

¢ Multiple overlapped Interactive CBLVCAT execution windows.

® Access to services such as job submission and the ISPF or CMS editor.
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Getting started with CBLi

1. Starting the CBLi program
2. Window Concepts

3. CBLi Main Window

4. Security Considerations
5. CBLi Clipboard

Starting the CBLi program

Before you start CBLi you need a mainframe 3270 terminal session. Most people now use a 3270 emulation program from a
workstation rather than a real 3270 terminal.

If you are using 3270 emulation we strongly recommend using the largest possible screen size. Screen sizes up to 62x160 for TSO
ISPF (this appears to be the maximum permitted for ISPF) and up to 86x190 for TSO without ISPF, CMS and VTAM (MVS and
VSE) are possible.

How CBLi is started depends on the environment in which it is to be run:

o/s Environment | Command

TSO/E Enter the command CBLI at the READY prompt.

ISPF Enter TSO CBLIl on the ISPF command line.

ISPF screen management is used and so CBLi must have first been defined as an ISPF application by
your systems programmer (as described in the CBL Interative installation Guide.) Otherwise enter TSO
MVS CBLi to execute using TSO 3270 screen management.

VTAM Enter LOGON APPLID(CBLIVTAM) on a VTAM USS screen.

Your installation may have other ways of invoking a VTAM application. Refer to the CBL Interative
installation Guide.

Note: The CBLi VTAM session controller program (CBLIVTAM) must be running and the CBLi VTAM
applid must be active.

VSE || VTAM Enter LOGON APPLID(CBLIVTAM) on a VTAM USS screen.

Your installation may have other ways of invoking a VTAM application. Refer to the CBL Interative
installation Guide.

Note: The CBLi VTAM session controller program (CBLIVTAM) must be running and the CBLi VTAM
applid must be active.

VM CMS Enter the command CBLI on the CMS command line.

Window Concepts

Window types

All windows exist in a hierarchy. At the top of the hierarchy is the desktop window which is automatically created during
initialisation. The desktop window covers the whole screeen and cannot be moved, resized or destroyed. All other windows,
including the CBLi application (main) window, are dependents of the desktop.

When an application creates a window the new window has to be dependent on an existing window, the parent or owning window.
If the application does not supply an existing window then the desktop window is used by default. This dependency relationship has
2 forms:

¢ Child window. The dependent window is a child of the existing window which is called its parent. The child window can
only exist within the rectangle defined by its parent's client area. Typically, child windows are used for low level entities
such as buttons and input fields.

e Owned window. The dependent window is owned by the existing window which is called its owner. The owned window
can be moved all over the display surface but is always infront of (cannot be obscured by) its owner. Typically owned
windows are used for more complex entities such as dialog boxes and help windows.

When a window is destroyed, so are all of its dependent owned and child windows.
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Getting started with CBLi Screen Sizes

Screen Sizes

The CBL 3270 screen manager can handle any 3270 screen size up to a total area of 16384 (16K) with a maximum width or depth
of 255. This 16K area limit is imposed by the 14 bit address format of the 3270 data stream used by CBLi. The 255 width or depth
limit is the result of some components using just 1 byte to store these dimensions.

Most 3270 emulation software packages allow the user to configure a 3270 session to emulate hardware terminal models 2/3/4/5
having rows x columns screen sizes of 24x80, 32x80, 43x80 and 27x132 respectively.

Some 3270 emulators also support the ability to define non-standard terminal sizes (IBM-DYNAMIC TN3270 terminals) that allow
users to obtain 3270 screen sizes with dimensions much larger than the standard hardware models.

Note: To configure non-standard screen sizes, IBM-DYNAMIC TN3270 terminal definitions must first be defined to VTAM and then
made available to users via the TN3270 server.

Whenever possible, users should use the largest screen size available to take full advantage of CBLi's ablility to display multiple
overlapping windows containing a variety of data. At CBL, screen sizes of 62x160 are regularly used for TSO (maximum supported
by ISPF) and screen sizes of up to 86x190 for CMS and VTAM (MVS or VSE).

A selection of popular 3270 emulator packages have been installed at CBL to determine whether support is included for
IBM-DYNAMIC terminals as well as some other additional features considered useful for use with CBLi execution (Keyboard
macros, etc.) The following link opens a page on the CBL web site that contains the results for each emulator tested to date.

http://www.cbl.com/cbli3270.html

Emulator configuration files and macros that are applicable to individual 3270 emulator packages, have been generated and
published on the CBL web pages for use with CBLi. Please see the following:

http://www.cbl.com/cblidl.html

Manipulating Windows

Moving a window
If a window has a title bar it can be moved with the following procedure:

1. Place the cursor in the title bar of the window.

2. Press the enter key. The window border will be highlighted.

3. Move the cursor to a new position.

4. Press the enter key. The window will move by an amount equal to the displacement of the cursor.

Also see CBLi command MOVEWINDOW and CBLe command SET WINPOS.
Resizing a window
If a window has a border it can be resized with the following procedure:

1. Place the cursor in the border of the window. If the cursor is in the top or bottom border, the window will have its
depth changed. If the cursor is in the left or right border it will have its width changed. If the cursor is in a corner
of the border it will have its width and depth changed.

2. Press the enter key. The window border will be highlighted.

3. Move the cursor to a new position.

4. Press the enter key. The window will be resized by an amount equal to the displacement of the cursor.

Also see CBLi commands SIZEWINDOW, DRAGBORDERMINUS, DRAGBORDERPLUS and CBLe command SET
WINSIZE.

Maximising a window
If a window has a maximise button it can be maximised by moving the cursor to the maximise button and pressing the
enter key. The window will then take up the whole of the 3270 screen. The maximise button will change from a plus sign to
a solid vertical bar (representing restore).
Also see CBLi command MAXIMISE and CBLe command WINDOW MAX.

Minimising a window
If a window has a minimise button it can be minimised by moving the cursor to the minimise button and pressing the enter
key. The window will then be removed from the display and replaced by a small iconic window showing just a portion of its
title bar near the botton of the CBLi main window. The minimise button will change from a minus sign to a solid vertical bar
(representing restore ).
Also see CBLi command MINIMISE CBLe command WINDOW MIN.

Restoring a window
When a window has been maximised or minimised, it can be restored to its former position and size by moving the cursor
to the maximise button or the minimise button (which will now contain a solid vertical bar representing restore) and
pressing the enter key.
Also see CBLi command RESTORE CBLe command WINDOW REST.

Closing a window

A window can be closed by moving the cursor to the close button and pressing the enter key.
Also see CBLi command CLOSE. CBLe command WINDOW CLOSE.
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Getting started with CBLi Window layout

Window layout

CBLi windows have a standard layout which consists of the following components. Not all windows have all these components, but
where present they occupy the same relative position in the window and have the same function.

The Title Bar
The title bar contains the title of the window.

The System Menu Button
The system menu button is at the left end of the title bar. If pressed the options of the system menu are displayed in a
popup menu.

The Minimise Button
The minimise button is at the right end of the title bar. It is represented as a single minus sign in white reverse video. If the
window is minimised then the minus sign is replaced by a solid vertical bar representing restore.

The Restore Button I
The Restore button is displayed in place of the Minimise or Maximise button when a window is in a minimised or
maximised state respectively. It is represented by a solid vertical bar in white reverse video.

The Maximise Button
The maximise button is at the right end of the title bar. It is represented as a single plus sign in white reverse video. If the
window is maximised then the plus sign is replaced by a solid vertical bar representing restore.

The Close Button _
The close button is at the right end of the title bar. It is represented as an x in red reverse video.

The Menu Bar
The menu bar occupies one or more lines below the title bar. It contains optional functions which can be invoked by
moving the cursor to the menu item and pressing enter. Some menu items when activated display popup submenus. The
menu items have the 3270 unprotected attribute so they can be selected by the tab key (which tabs to enterable fields).
Any data entered into a menu item is ignored.

Menu items may be enabled or disabled. When enabled they are displayed in white. When disabled they are displayed in
blue and selecting them will have no effect.

The Client Area
The client area of a window is the main body of the window and its contents vary depending on the class of the window.

The Command Line
The command line is an area of the window into which text commands may be entered. Most menu items have a
command line equivalent text command.

Pressing buttons

The 3270 architecture is such that the host is only informed of user input when a certain class of key is pressed on the keyboard.
These keys are those with attention identifiers and typically consist of the function keys, the enter key, the Program Attention (PA)
keys and a few other specialised keys. Even when operating under the control of a workstation 3270 emulator, the 3270 host
application is not sensitive to mouse movements (except in the case when the emulator allows the user to assign a particular 3270
function to the mouse buttons).

Because of this, 3270 window buttons cannot be "pressed" in the same way as work station window buttons. 3270 window buttons
are "pressed" by:

1. Moving the cursor to the button and
2. Pressing the enter key.

Window Focus
The focus window is the window which contains the cursor when the 3270 screen is displayed. If the window has a title bar then the

fact that it is the focus window is indicated by colouring the title bar area with blue reverse video. All other windows have a white
reverse video caption bar.

Input fields

The focus window defines the input rectangle which is the only area of the screen where input is enabled. When the focus window
is not a child window the input rectangle is the window itself.

When the focus window is a child window the input rectangle is that defined by its parent. Any input fields outside of the input

rectangle are temporarily disabled. Each field in the input rectangle can be visited by using the cursor tab key (shift+cursor tab key
to reverse the direction).
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Getting started with CBLi Window Focus
Changing the focus window
The user can change the focus window in the following ways:
¢ By placing the cursor in a window and pressing enter. This sets the focus to the window containing the cursor.
¢ By using the PREVWINDOW, NEXTWINDOW, MDIPREV or MDINEXT commands. These commands cycle through all
windows in creation sequence. By default, PF9 is assigned to MDINext in MDI applications such as CBLe and SELCOPY
Interactive, and Nextwindow elsewhere.
¢ By using the Window item of the CBLi main menu or the WINDOWLIST command to open the Window List window and
then selecting a window by moving the cursor to the relevant entry and pressing enter. The selected window becomes the

focus window.
¢ By using the SETFOCUS command to explicitly name the focus window.

Window Names

All the windows defined by a CBL3270 application have a name. The name is supplied by the application when the window is
created and may be changed later during the window's life.

If the name is not supplied by the application then a default name is supplied by CBL3270 made up of the window class name
suffixed with a three digit number which is incremented by 1 for each window of the class created during the CBL3270 session.

The main use of window names is to allow commands entered on the command line of a window to refer to other windows which
are currently part of the application.

Viewing Window Names

The window name associated with each non-MDI window in the CBLi session may be displayed in that window's title bar (and
subsequently hidden from view) via the following:

e Select 'Display/Hide Window Names' from the system menu belonging to any open window.
¢ Enter the CBLi command WINDOWNAMES on the command line of any window.

Either of these operations will display or hide the window names for all open windows in the CBLi session.
Display of all MDI window names (e.g. CBLe text editor window names) has been suppressed to avoid overcrowding the title bar.

Alternatively, the Window List window may be used to obtain a window's associated window name. The window list displays all
open windows and their associated window names (including MDI window names.)

Window Class

All the windows defined by a CBL3270 application are members of a window class. A window class represents a set of windows
with the same behaviour and appearance. Window classes are identified by a 1 to 8 character name.

CBL3270 uses the window class name to associate a processing module (called the Window Procedure ) with the window.

All windows in the same class are managed by the same window procedure. The window procedure is called by CBL3270
whenever an event occurs which affects the window. It is the window procedure's responsibility to:

1. Paint the window client area.

2. Process any data entered into the window.
3. Respond to any commands issued from the window's menu or command line.

Window List

The Window List window may be opened via the following:

e Select 'Window' from the CBLi Main Menu.
¢ Enter the CBLi command WINDOWLIST on the command line of any window.

The Window List window displays all open windows and their associated window names and allows the user to place focus on a
specific window. The ENTER key should be pressed with the cursor on the line containing the required window.

The hierarchy of parent/child windows is illustrated by indentation of the entries in the list.
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Getting started with CBLi Window List

Jirmdoww LIt .
WCIWMAIM: CEL1I for TS50 1.6B - Build=200811191244 OpSy=s==z.-05 1.49.0 User=HEJZ
SDEWUDEUG: SELCOFPY
STORAGE: Work Area
SYWSFPRIMNT: MEBJZ.SELCOPRPY.SSDEMOOL1. S%SFPRIMT 1232 W SE0Q Size=123 A
TRACE: MEJZ.SELCOPY.SSDEMOGOL. TRACE 122 % SEQ Size=1 Alt=0,0:2
SYSIM: CEL.SSC.CTLI(SSDEMORDL] 218 w FDESE Size=9E AlLt=0,0;0
EDTUWMAIM: CELe
EDTWEDIT1: HMEBJZ.CELI.IMI 255 W SENQ Size=7E ALt=0,03;0
LISTFILE: Library Lis=t: CEL.JCL
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WCIWE®XEC1: Execute CELWCAT
EDTWEDIT: CEL.CHMxX([(MBEIZ2) 252 W FDSE Size=323232 Alt=2_,2:2

Figure 1. Window List window.

Function Keys

Function key command tables are maintained for keys F1-F24 at the following levels:

Window For each window instance.

Class For each window class.

|Caption One table for the caption area (title bar) of all windows.
Border One table for the border area of all windows.

Default One table of system defaults.

When a function key is pressed the command to process is selected as follows:

. If the cursor is in the caption or border of a window then the appropriate function key table is searched.

. If no command is assigned to the key then no command is processed (the default table is not searched).

. The function key table of the window with the cursor is searched.

. If no command is assigned then the class table for the window with the cursor is searched.

. If no command is assigned then the default table is searched.

. If no command is assigned then the search is repeated for the parent window of the cursor window and so on up the
window hierarchy until the desktop window is reached.

oUW =

Function keys settings may be displayed and updated using the Function Keys window or the KEYS command.

CBLi Main Window

On starting CBLi the main window is openend.

for TS0 i - Euild=2@0S@87=Z0i1527

File List UDti1ilities System Window SwaplList Heiﬁ
Command:?

SELCOPY~1 1.7FEB (C)12009 Compute(Bridgend) Ltd UK +44(1ESE1ESZ222
website: http: " “www.cbl.com
email: support@chbl.com

Operating System: =05 1.35.0 SELCOFY. i Build: Z0Q09Q0F7Z015Z27

Figure 2. CBLi Main Window.
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Getting started with CBLi CBLi Main Window
The main window contains:
¢ A title bar. Located at the top of the window, it includes:

+ A system menu button at the extreme left. This button accesses the system menu options.
+ The window name.
+ A minimise button as the third character from the right.
+ A maximise button as the second character from the right.
+ A close button as the first character from the right.
e The menu bar. Located immediately below the title bar, it lists the main menu options.
¢ The client area. Occupying the body of the window, it contains:

+ The CBLi logo, copyright notice and contact details.
+ The operating system name and version.
+ The user id.
+ The build level of CBLi. This information is useful for communicating with CBL when a query is raised about CBLi
features or problems.
e The command line. This is the bottom line of the window.
Commands may be entered at the Command> prompt to invoke CBLi facilities that duplicate or extend the menu facilities.

You can launch CBLi facilities by doing the following:

¢ Select a CBLi main menu option by moving the cursor over the option in the menu bar and press ENTER.
e Entering a CBLi line command.

System Menu
The system menu is a menu of functions which is available on all windows within a CBL3270 environment.

You access the system menu by pressing the system menu button at the top left of the main window (or any subordinate window
that has a system menu button). The following options are available from the system menu:

Layout Storage Display Windows only, displays the options popup menu. (As for
SHOWPOPUPMENU.)

Restore Restore a maximised or miminised window to its original size and position.

Minimise Minimise the window with the system menu.

Maximise Maximise the window with the system menu.

Close Close the window with the system menu.

Quit Quit the application.

Window List Open a window showing the current list of windows. You can select a window from this
list by placing the cursor on a list element and pressing enter. The selected window will
be given the focus.

Next window Give the focus to the next window in the hierarchy of open windows.

Prev window Give the focus to the previous window in the hierarchy of open windows.

Command line Open the command line dialog.

Function keys Open the functions keys dialog.

Show/Hide window names || Toggle the status of the window names display. Window names are unique window
identifiers which can be used in commands to identify a particular window. If displayed,
the window name is displayed in the title bar as a prefix to the window caption.

Use ISPF/TSO When running under TSO/ISPF, this menu command toggles the display from ISPF to
TSO format.

Function Keys Window
The Function Keys window may be opened via the following:

¢ Select 'Function Keys' from the System menu belonging to the window for which function keys are to be displayed.
¢ Enter the CBLi command KEYS on the command line of the window for which function keys are to be displayed.

The Function Keys window displays the current PFKey table settings for a CBL3270 window.

CBLi maintains function key tables at 5 levels (i.e. Window, Class, Default, TitleBars and Borders). The function actioned by any
PFkey is determined by these levels as discussed in the topic Function Keys.

The function key table for any of the levels may be displayed and updated by first selecting the desired level from the Function
Keys menu.
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Getting started with CBLi

Function Keys Window

All the displayed fields, other than the Key field, are enterable. Changes made to the table are only obeyed once the user has
confirmed (saved) the changes on exit of the Function Keys window.
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Figure 3. Function Keys Window.

Columns Displayed

IName Description

KEY PFKeys 01-24 (Non-enterable field)

DELAY |[Determine whether the associated command is executed immediately when the function key is hit or merely
placed on the local command line.
Valid entries are Y or N.

BEFORE |Determine whether the associated command is executed before or after any other CBL3270 screen input. (e.g. a
command line command or prefix area command.)
Valid entries are Y or N.

untitted | The command(s) associated with the PFKey. For CBLe, a number of commands may be issued if separated by
an appropriate separator character.

Default Function Keys

The CBLi Window, Class and Borders function keys are unassigned by default. The CBLi Default function keys are assigned to
the following (unless overridden by the SYSTEM/USER CBLi INIFILE):

PF1 Top Display data at the top of a scrollable window.

PF2 Bottom Display data at the bottom of a scrollable window.

PF3 Close Close the window in which the cursor is positioned. (N.B. not necessarily the current focus
window)

PF4 CmdText Issue command at the cursor position if prefixed by "<" (less than), otherwise place text on
the command line.

PF5

PF6

PF7 Up Cursor Scroll up the file so that the current focus line becomes the last line of the display.

PF8 Down Cursor Scroll down the file so that the current focus line becomes the first line of the display.

PF9 NextMainWindow Place focus on the next main window in the CBLi window list.

PF10 Left Cursor Scroll the display to the left so that the current focus column becomes the last column of
the display.

PF11 Right Cursor Scroll the display to the right so that the current focus column becomes the first column of
the display.

PF12 Retrieve - Retrieve the last command issued and place it at the command line.

PF13

PF14

2009/07/20 16:03:29

CBL Interactive (CBLi)




Getting started with CBLi

CBLi Main Menu

PF15

PF16 CmdText Edit

Issue command at the cursor position if not prefixed by "<" (less than), otherwise place
text on the command line.

PF17

PE18

PF19

PF20

PF21 PrevMainWindow

|Place focus on the previous main window in the CBLi window list.

PF22

PF23

PF24

The CBLi TitleBars function keys are assigned to the following:

PF1

PE2

PF3

PF4

PF5

PE6

PF7

MoveWindow by y=-1

Reposition window up 1 line

PES8

MoveWindow by v=+1

Reposition window down 1 line.

PF9

PF10

MoveWindow by x=-1

Reposition window left 1 column.

PF11

MoveWindow by x=+1

Reposition window right 1 column.

PF12

PF13

PF14

PF15

PF16

PFi17

PF18

PF19

PF20

PE21

PF22

PF23

PF24

CBLi Main Menu

The CBLi main menu is listed in the menu bar at the top of the CBLi main window. You select a menu item by tabbing the cursor to
the menu item and pressing the enter key. Menu items can also be activated with commands entered on the command line.

The main menu consists of the following items:

debug

Execute SELCOPY

Open the Execute SELCOPY debug window.

Execute CBLVCAT

Open the Execute CBLVCAT (VCI) window.

Edit

Open the CBLe text edit window.

DB2 Dynamic SQL

Open the DB2 Dynamic SQL window.

File Allocate NonVSAM

Open the Allocate NonVSAM dialog.

Execute IDCAMS

Open the IDCAMS Command window.

Define KSDS Open the Define KSDS dialog.
Define ESDS Open the Define ESDS dialog.
Define RRDS Open the Define RRDS dialog.
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Storage Display Window

Define LDS Open the Define LDS dialog.

Define AIX Open the Define AIX dialog. - Not yet enabled
Define Path Open the Define Path dialog. - Not yet enabled
Define Alias Open the Define Alias dialog. - Not yet enabled

Define Catalog

Open the Define Catalog dialog. - Not yet enabled

Execute POWER

Open the POWER Command Output window.

DASD Volumes

Open the DASD Volumes list window.

Cataloged files

Open the Cataloged files list window.

Dataset details

Open the Dataset details list window.

List X
VTOC files

Open the VTOC files list window.

VTOC extents

Open the VTOC extents list window.

Allocated files

Open the Allocated files list window.

Library members

Open the Library members list window.

Enqueues

Open the Enqueues list window.

Job Enqueues

Open the Job Enqueues list window.

File Search

Open the File Search window.

Utilites Calendar

Open the Calendar window.

Calculator

Open the Calculator window.

SDSF

Under TSO or ISPF, call the SDSF JES2 spool access program.

ISPF Dataset Utilities

Under ISPF, call the ISPF dataset utilities menu panel.

Operating System

Open the Operating System window.

System CBLi storage stats Open the CBLi Stoarge statistics Block window.
CBLi module list Open the CBLi Module List window.
CBLi SVC Open the CBLi CBLVCAT SVC information window.
CBLNAME Open the CBLNAME storage display window.
Window Open the Window List window.
SwapList Displayed only if ISPF is the 3270 screen manager. Execute ISPF SWAPLIST
command.
Help Open the help top level window.

Storage Display Window

Storage display windows provide a view of an area of storage in dump format.

Supported items that utilise storage diaplay windows are:

¢ CBLNAME Window.

e SELCOPY Interactive Workarea windows.
e SELCOPY Interactive POS windows.

e CBLe HEX Windows.

Window Display Format

The length of storage data displayed may be restricted by the type of window opened. e.g. The amount of data displayed in a CBLe
HEX window is restricted to be the length of the focus line.

Each row of a storage display window has the following format:

|Address in storage of the displayed data.

Displacement from the start address of the displayed data.

Data in storage in hexadecimal format.
(4, 8, 16 or 32 bytes depending upon window size).

|Field Width Type Description
8 Hex

6 Ulnt

8,16,32 or 64 Hex

4,8 ,16 or 32 Char

Data in storage in character format.
(Field width adjusts automatically to match hexadecimal display width.)
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Getting started with CBLi Storage Display Window

The format of the display may be updated using the options popup menu which may be opened using the SHOWPOPUPMENU
command or via the system menu button of the storage display window. By default, the SHOWPOPUPMENU command is
assigned to PF5 in storage display windows.

Window Sizing

User resizing of a storage display window's width will always be adjusted by CBLi to display one of the valid data display widths. i.e.
1, 2, 4 or 8 words of hexadecimal data plus its equivalent character representation if required.

If the window's width is increased or decreased by one column, the window's width is rounded up or down respectively to equal the
next valid display width. e.g. When using DRAGBORDERPLUS and DRAGBORDERMINUS (assigned to PF8/PF11 and PF7/PF10
respectively) on either of the window's vertical borders.

If the window's width is increased or decreased by more than one column, the window's width is always rounded down to equal the
next valid display width.

Navigating Data

The displacement field in the first row of a storage display window is an enterable field (highlighted in red by default.) This field may
be overwritten with a displacement, from the start address, of the byte that should be displayed first in the storage window's display
area.

CBLi commands UP CURSOR and DOWN CURSOR may be used to navigate the storage display window. By default, UP
CURSOR is assigned to PF7 and DOWN CURSOR is assigned to PF8.

Manipulating Data

Some storage display window invocations allow the data to be updated simply by overtyping the existing character or hexadecimal
representation and then, to commit the change, hitting <Enter>.

Security Considerations

VSE Systems

By default, the SYSTEM CBLIlNI file has the System variable VSESMLogon=YES. This activates CBLi's VSE Security Manager
(BSM or ESM) logon and resource checking.

In order to operate successfully with VSESMLogon=Yes, the VSE system must be running a security manager and the CBLi startup
job submitted so that it provides the CBLi program with maximum user privilages. At CBL, the job that starts CBLi contains a JECL
* $$ JOB statement with SEC=(SYSA,...).

Any user wishing to login to CBLi must have a logon id defined in the security manager's data base. Once logged in, CBLi will
interrogate the security manager to establish the user's access privilage prior to performing any action on potentially protected
resources. e.g. listing LIBR library contents and editing LIBR members. CBLi will then permit or restrict the user's access to the
resource.

If VSESMLogon=0OFF, then no logon password or security manager resource checking is performed.

With VSESMLogon=ON in effect, editing of VSE Power queue entries is possible if either the TO or FROM values match the

current user's userids. However, if VSESMLogon=OFF a user may only edit a Power queue entry if it is password protected and
the password is known to the user.

MVS Systems

On MVS systems, users login to CBLi using their RACF, or equivalent security package, login id. Under TSO, no CBLi login is
performed as the user's TSO login id is used instead.

Thereafter, the user's access privilage is verified prior to performing any action on potentially protected resources. e.g. listing
PDS(E) library contents and editing data sets.

In addition to this, the security administrator can restrict users' access to the following CBLi features using RACF profiles.

Resource Name | CBLi Feature

System Access to the 'Operating System' information available via the 'System' menu item on the main desktop
or via the commands: SysI, SysLPA, SysLL, SysAPF, SysTask, SysStor, SysPgm and CBLNAME.

UserTSO Log on to CBLi under TSO and ISPF.

UserVTAM Log on to CBLi as VTAM application.

SELCOPY Use of the SELCOPY Interactive application.

CBLVCAT Use of the CBLVCAT Interactive application.

DB2 Use of the DB2/SQL Interactive application.
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Getting started with CBLi Security Considerations

Restrictions are implemented via options in the CBLi SYSTEM (site wide) CBLIINI file, and cannot be overridden by an individual's
USER CBLIlNI file. These options must be entered in the (RACF) section of the CBLIINI file and are as follow:

CBLIlINI Variable Description

ResourceCheck=NO|YES Use RACF for CBLi resource access checking (default NO).
ResourceClass=ClassName RACF general resource class (default FACILITY).
SuppressWTO=NOI|YES Suppress access failure WTO messages (default NO).
System=ResourceName System commands resource name (default CBLI.SYSTEM)
UserTSO=ResourceName TSO user access resource name (default CBLI.USER.TSO)
UserVTAM=ResourceName VTAM user access resource name (default CBLI.USER.VTAM)
SELCOPY=ResourceName Interactive SELCOPY resource name (default CBLI.SELCOPY)
CBLVCAT=ResourceName Interactive CBLVCAT resource name (default CBLI.CBLVCAT)
DB2=ResourceName Interactive SQL resource name (default CBLI.DB2)

With RACF.ResourceCheck=YES in effect, users without a minimum of READ access to the specific resource will be rejected.

In addition to these CBLIlINI options, RACF, or an equivalent security package, must be active and a RACF profile must exist that
includes the resource name. The resource name may be generic; for example the profile CBLIL.** with UACC(READ) would permit
all users access to all resources.

Note that MVS system symbols may be used in the resource names These will be resolved when reading the system CBLIlNI file.
e.g.

(RACF)
DB2=CBLI.&SYSNAME. .DB2 * Interactive SQL resource name

Please see the distributed CMX file &PREFIX..CBLI.CMX(RACF) for samples of commands useful in administering CBLi RACF
resource restrictions.

CBLi Clipboard

CBLi supports a clipboard facility to allow users to Copy, Cut and Paste data between windows running in the CBLi environment
that support clip board functions.

At this time, clipboard facilities are only supported in CBLe and SDE edit and browse views. e.g. Data copied to the clipboard from
an edit view in the SELCOPY Interactive application may be pasted to an edit view in the CBLe text edit application.

Note that the CBLi clipboard is not associated with any other clipboard facility offered by the system.
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Executing SELCOPY

1. Invoking SELCOPY Interactive

2. Load Library Search Chain

3. SELCOPY Interactive Windows

4. SELCOPY Interactive Commands

5. SELCOPY Interactive Function Keys

Invoking SELCOPY Interactive

The SELCOPY Interactive application window is started via the following:

¢ Select 'Execute SELCOPY' from the File menu in the CBLi window main menu.
e Enter the CBLi command SELCOPY on the command line of any window.

See also the CBLe macro, JCLCMX , which is a pre-processor tool used to convert MVS JCL decks containing SELCOPY steps

into a format suitable for input to SELCOPY Interactive. Simply edit the JCL deck using CBLe, then key in JCLCMX from the edit
command line to generate command files containing ALLOC commands that correspond to the DD statements; CALL commands
that correspond to EXEC statements; and SELCOPY commands that correspond to EXEC PGM=SELCOPY statements.

A control file name containing the SELCOPY source statements must be provided as SYSIN/SYSIPT input to the SELCOPY
Interactive window either as a parameter on the SELCOPY command or via the "Run SELCOPY" dialog window. The control file
may be specified as a complete fileid (DSN) or as a previously allocated filename (DD/FILEDEF/DLBL) which may be a
concatenation of data sets. e.g.

selcopy -ctl cbl.ssc.ctl (ssdemo01)

CtlFiler cbhbl.ssc.ctlissdemodi)
ArgStringr
FgmMame> SELCOPY
LoadLibx
*
*

F5SEMame: Im
EMP >

Figure 4. Run SELCOPY Dialog Window.

If the specified control file is empty or does not yet exist, then SELCOPY Interactive opens an empty SYSIN/SYSIPT CBLe text edit
view and, on performing its initial control statement analysis, reports ERROR 14 "NO INPUT FILE" in the SYSPRINT/SYSLST view
with pop-up message:

SDBO02E SELCOPY has ended with control card errors. Return Code 52.

Having selected OK to continue, the user may proceed by adding SELCOPY control statement records to the control file
SYSIN/SYSIPT window. When complete, the changes to the control file should be saved before executing RERUN to begin
debugging the new SELCOPY statements. If the SELCOPY control fileid does not already exist, then for MVS systems, the
Allocate NonVSAM dialog will be opened before the save is actioned.

When SELCOPY Interactive starts, the Execute SELCOPY main window is opened together with a CBLe edit view for the control
statement SYSIN/SYSIPT input. If the SYSIN/SYSIPT file name was specified as an explicit fileid (DSN) which is not locked
(ENQ'd) by another process and the user has sufficient authority, the file is edited Read/Write. Where the SYSIN/SYSIPT input file
name was specified as a previously allocated filename (DD/FILEDEF/DLBL), then the data is edited Read/Only.

The SELCOPY program is then executed and stopped following control statement analysis but before actioning the first executable
statement. The user may then begin debugging and stepping through the statements.

Note that interactive execution of SELCOPY using statement stepping and/or break points is not supported if the SELCOPY control
file contains the SELCOPY option NOPRINT, NOP or NOPCTL to suppress print of the SELCOPY control statements. If any of
these options are specified prior to the first control statement, then the job will run to completion without stopping.

Any required SELCOPY input or output files must be allocated before execution of SELCOPY Interactive. This excludes SYSIN and
SYSPRINT which are handled by the CBLi window management software. See the CBLe ALLOCATE command and, where the
SELCOPY statements form part of an MVS batch stream, use the CBLe JCLCMX REXX macro to configure the environment prior
to starting SELCOPY Interactive.
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Executing SELCOPY Invoking SELCOPY Interactive
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Figure 5. SELCOPY Interactive Debug in 62x160 3270 Session.
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Executing SELCOPY Load Library Search Chain

Under MVS, interactive execution of IMS SELCOPY programs in DLI and BMP region types is supported.
The following SELCOPY Interactive attributes relating to IMS SELCOPY programs may be specified as a parameter on the
SELCOPY command or via the "Run SELCOPY" dialog window.

e The PSB name.

e The IMS region (either DLI or BMP). Default is DLI.

¢ The Subsystem name of the IMS Region to which the connection should be made. (Optional)
¢ IMS Application Group name. (Optional)

For IMS DLI regions, IEFRDER, DFSVSAMP must either be allocated or included in the SYSTEM or USER CBLIINI file for
dynamic allocation by SELCOPY Interactive at execution time.

Load Library Search Chain

The location of the SELCOPY program executed and any routines called by the SELCOPY operation, CALL, is determined by the
standard search chain for the current environment.

Note: The SELCOPY CALL operation is used to pass control to an external Assembler, COBOL routine or any MVS program
module developed using Language Environment.

For MVS systems only, SELCOPY Interactive provides users with the ability to include additional libraries to the start of the search
chain. This gives the SELCOPY Interactive environment an equivalent to the STEPLIB JCL statement, which may occur in
SELCOPY batch jobs.

The included library path may be entered in the "Run SELCOPY" dialog window or via the -LIB parameter on the CBLi CLI
SELCOPY command, as one of the following:

¢ A DDname which has been pre-allocated to one or more load libraries.
* One or more load library DSNs separated by ', ' (commas), '; ' (semi-colons) or ' ' (blanks).

Note: If the DSNs are separated by blanks, quotes must also be used to delimit the list of DSNs, not the individual DSNs.
The following SELCOPY line command and "Run SELCOPY" dialog examples illustrate use of LibPath.

selcopy -ctl INCTL -1lib "SYS3.TEST.LOADLIB SYS3.NBJ.TEST.EXE"

FOr SELCOPY o ——

CtlFiler SYS2.TEST.SELCOPY.CTLO1GEZR
ArgStringr
FgmMame> SELCORPY

LoadLib} S%S3.TEST.LOADLIES SY¥S52.MBJ. TEST. EXE
¥
»
FSEMame? IMSId:
EMP > AGH>
[ Fun Help

Figure 6. Run SELCOPY Dialog Window with Load Library Path.
This feature is exploited by the JCLCMX CBLe REXX macro which translates JCL statements from a batch job into the equivalent
CBLi commands, thus setting up an environment suitable for interactive execution of a SELCOPY batch job.

Where STEPLIB JCL statements are found in EXEC PGM=SELCOPY steps, the library names are included on a -LIB parameter in
the generated, equivalent SELCOPY command.

SELCOPY Loop Break-in

The nature of SELCOPY execution is such that statements are executed sequentially, or as directed by logic flow operations (e.g.
GOTO, PERFORM), until either the last control statement of the SYSIN/SYSIPT input is encountered or a GOTO GET operation is
executed.

When one of these conditions occur and at least one input (e.g. READ) and one output (e.g. WRITE, PRINT, UPDATE) operation
exists, then processing is passed back to the first run-time control statement in the control deck.
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Executing SELCOPY SELCOPY Loop Break-in
This looping through the control statements will continue until one of the following occurs:

1. fEnd;}of-fFliIe condition is encountered following an attempted READ of the prime input file and no IF EOF condition exists
or the file.

2. No further output operations are eligable for execution as a result of a explicit or implicit STOPAFT value. e.qg.
STOPAFT=50 is implied for LOG output operations and STOPAFT=1 is implied for operations executed based on a true
IF INCOUNT condition for equality.

3. GOTO EOJ or GOTO CANCEL operation is executed.

4. A Selection Time Error is encountered.

If none of these conditions occur, then it is possible to introduce an infinite loop in SELCOPY control statement processing.

The SELCOPY Interactive debugger may be used to identify the cause of this situation or any sequence of statements that cause
the control statement stream to loop. It is possible, however, that the user may not know that the loop condition exists until
SELCOPY processing has been restarted without a break point in which case, since SELCOPY is executing in the foreground, the
3270 session becomes unresponsive.

It is for this reason that the SELCOPY default break-in facility exists to allow the user to pre-define a default number of times that
any control statement within the SELCOPY job stream may be executed before a virtual break point is encountered and processing
is paused.

This break-in threshold is controlled via the CBLiINI option SELCOPY.LoopBreakln which has a default value of 1,000,000.
When the break-in threshold has been reached, a pop-up message window is opened and control is passed back to the user to
continue debug investigation. This means that there is no need to forcibly end the CBLi session and restart the SELCOPY debug
process.

Note that a loop break-in may occur even though a loop is not infinite. (e.g. the prime input file may have a number of records
greater than the break-in threshold.)

SELCOPY Interactive Windows

SELCOPY Interactive Main window

Like the CBLe text editor, SELCOPY Interactive is an MDI (Multiple Document Interface) application. An MDI application comprises
a parent (frame) window with a menu bar and a client area within which one or more MDI child windows are displayed. All MDI child
windows are confined to the parent window's client area.

The SELCOPY Interactive Main (frame) Window supports all MDI child windows supported by the CBLe frame window (including
SDE Edit). The SELCOPY Interactive frame window is actually a CBLe frame window with additional features and characteristics
specifically relating to SELCOPY execution. These features are discussed in this section whereas details on CBLe frame window
features may be found in the CBLe Text Edit documentation.

The SELCOPY Interactive Main window must always contain the Control Cards, Output Listing and TRACE Windows. Closing any
of these windows will quit the SELCOPY main window and so end the Interactive session.

When a session is started, these 3 child windows are automatically opened, together with a work area storage window, at fixed
locations within the main window client area. The position and size of each window have been pre-determined so that the contents
of each window are easily visible when used with terminals of width greater than 80 bytes. Where the terminal display is of width
less than 80 bytes, the SELCOPY Interactive child windows are opened in a maximised state, however, these may be
subsequently restored, resized and repostioned as in Figure x.
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Executing SELCOPY SELCOPY Interactive Main window
SELCOFRY
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# Mow print the table.
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then goto drop
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goto readloop

# Mow drop the table.
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=
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Figure 7. SELCOPY Main Window in 43x80 3270 Session - Resized Child Windows.

Note that the "Ws" (Window Save) button may be used to save a focus child window's size and location within the parent window
so that it may subsequently be restored using the "Wr" (Window Restore) button. This enables the user to maintain preferred
window size and location across invocations of SELCOPY Interactive.

All SELCOPY Interactive child windows, other than list and storage windows, are CBLe text edit windows (i.e. Control Cards,
Output Listing, trace and log windows.) This allows the user to edit the data in these windows and to issue CBLe commands and
macros such as ALL, LOCATE, CHANGE and SAVE.

In addition to the standard SELCOPY Interactive windows, the user can open a CBLe edit view for any other file (e.g. the input data
sets, etc.), thus giving SELCOPY Interactive all the features provided by the CBLe text editor. Also, if MDILIST is ON (default), any
LIST window opened from a SELCOPY Interactive child window will itself be a child window of SELCOPY Interactive.

By default, PF9 is assigned to CBLi CLI command MDINext and is used to pass focus between the SELCOPY Interactive child
windows.

SYSIN Window

The SYSIN window is opened automatically when SELCOPY Interactive is started. It may also be opened via the following:

® Select 'Control Cards' from the View menu in the SELCOPY Main Menu.
e Enter the SELCOPY Interactive CLI command WINDOW CTL.

The SYSIN window is an edit view that contains the control statement source file as required for execution of SELCOPY
Interactive. This window highlights the current operation and allows the user to set and unset break points.

By default, SELCOPY Interactive attempts to edit the SYSIN file read/write. If this is not possible, the user is prompted to continue
the session with the file edited in read only mode. In either case, the edit profile macro is executed when the file is loaded. If the
CBL supplied macro PROFILE is set as the default edit profile, then useful edit buttons are added to the menu bar. See the
PROFILE and PROFIRST macros for a description of each button's use.

Note that SELCOPY analyses the control statements prior to execution and it is at this point that SELCOPY Interactive associates
each operation in the SYSIN display with its appropriate selection id. Therefore, any alterations made to the SYSIN data during
SELCOPY debugging must first be saved and the job re-started before any further statement execution can take place.

The contents of the window scroll automatically in order to display the current statement in the SELCOPY execution. As for any edit
view, CBLe commands and macros may be used to manipulate, highlight and locate data in the view (e.g. LOCATE, TAG, ALL,
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Executing SELCOPY
CHANGE, SET ZONE, etc.)

SYSIN Window

In addition to any CBLe edit highlighting, during the course of execution control statements are highlighted as follow:

1. Next executable SELCOPY statement. Default highlight - pink reverse video.
2. Break Point. Default highlight - red reverse video.

Closing the SYSIN window also exits SELCOPY Interactive.

SYSPRINT Window

The SYSPRINT window is opened automatically when SELCOPY Interactive is started. It may also be opened via the following:

e Select 'Listing' from the View menu in the SELCOPY Main Menu.
¢ Enter the SELCOPY Interactive CLI command WINDOW LIST.

SELCOPY Interactive intercepts output to SYSPRINT/SYSLST and displays it in the SYSPRINT window instead. For this reason,
SYSPRINT or SYSLST does not need to be allocated and no output is written to the system spool.

The contents of the SYSPRINT window scroll automatically to display any new output to SYSPRINT/SYSLST. Data written to the
SYSPRINT window is maintained until the SELCOPY Interactive session is closed. Therefore, so long as the SELCOPY Interactive
session is not closed, the job may be re-run any number of times without loosing the SYSPRINT/SYSLST output from a previous

run.

The SYSPRINT window is an edit view which supports execution of CBLe commands and macros. This allows the user to
manipulate, highlight and locate data in the view (e.g. LOCATE, TAG, ALL, CHANGE, SET ZONE, etc.)

Unless SELCOPY options NOPRINT or NOPCTL are specified in the control statements, the input statements and their selection
ids are also written to SYSPRINT. Similarly, unless SELCOPY options NOPRINT, NOPSUM or NOPTOT are specified in the
control statements, the summary totals are written to SYSPRINT at end of job.

Figure 8. SELCOPY SYSPRINT Window.

SQL Log Window

The SQL log window may be opened via the following:
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Executing SELCOPY SQL Log Window

¢ Select 'SQL log' from the View menu in the SELCOPY Main Menu.
e Enter the SELCOPY Interactive CLI command WINDOW SQL.

A SELCOPY job that submits SQL statements to a DB2 data base, also writes detailed information about the SELCOPY SQL
processing to a data set allocated to ddname CBLSQLOG.

SELCOPY Interactive intercepts output to CBLSQLOG and displays it in the SQL Log window instead. Because of this,
CBLSQLOG does not need to be allocated to display this information.

The SQL Log window is an edit view which supports execution of CBLe commands and macros. This allows the user to
manipulate, highlight and locate data in the view (e.g. LOCATE, TAG, ALL, CHANGE, SET ZONE, etc.)

JewateanedlinnetieneZrnnetenreSansateneadensateneaSennstenesBanastaraaTasantonaaas
oinlolofo bR #*
L1 it il ittt ittt
gggggg CELEZ01@I 16:55i52 CEL Dunamic QL Interface iz started. CLate: Zoa9-oi-14
nOEEns CELEOE@I 16:155i55 (Sel 1) Connected to DEZ Version 9.1.0
[ZEIE Zubsystem: CEIG Flan: CELPLAMG
oinloiofo iy =er i MNET Current =QLIC:HET
ololoiofo b=
DOEDES CELSDETI 16IS5I55 (Sl 13 EXECUTE CREATE Z0L Code=a
oinjoiokRn}
[ololoioR create table 911525 ¢ char char{i@) not null with default, decl dectl,d
QEnD1Z Dot nill with default, decZ 4decil,®) not null with default,
DI LS decs decil,1? not null with default, intli int not nwll with
olololo e default, decd deciz,d) not nwll with defawlt, decs deciz,@) not
ololo]ok =1 null with default, decg dectz,2) not nwll with default, dec? dect
QEED1E S,3) not null with default, decs decd4,32 not null with default,
oinloiok ey intz int not null with default, decd decisS,52 not null with
olololok k=3 default, dech decid,@r not null with default, decE deci3,@) not
DDEELS null with default
olnlniofedn) EZ CPU= Qoo@om.Z6d434F seconds.
DD EL
OOEEEE CELE@OTI 16155155 (el 2) EXECUTE COMMIT SQL Coda=a
DI ES CPU= Q@@oon. @3agasm seconds.
oinoiobet )
gggg%g CELSOATI 16i55:55 (Sel 5» EXECUTE INSERT 0L Code=a
DEEDET insert into Sq11525 walues ('Zero raw i, O, @, @,0, O, O, O, @, O, @O,
DDEEES o]
DI ES Rows Inserted=1 DEZ CPU= @Qoo@oEn. 59964 seconds.
olololofein)
OoEnEl CELSDETI 16155156 (Sl 43 EXECUTE IMSERT Z0L Code=a
IDIENESE
olololofcic] insert |nTD =q1152% walues ('First row ',1,-1,-8.1,-5,1,-1,-0.01,-@,001,
oinlolokcs DOl ,-S, -0, 001 ,9,9)

Figure 9. SELCOPY SQL Log Window.

WTO Log Window

The WTO log window may be opened via the following:

e Select 'WTO log' from the View menu in the SELCOPY Main Menu.
¢ Enter the SELCOPY Interactive CLI command WINDOW WTO.

SYSLOG output to the Operator's Console, TSO, CMS or ICCF user terminals is intercepted by SELCOPY Interactive and is
displayed in the WTOLOG window instead.

The WTO Log window is opened automatically when SYSLOG output is received. This may be warning/error messages returned
by SELCOPY, or output generated by a SELCOPY LOG operation.

The WTO Log window is an edit view which supports execution of CBLe commands and macros. This allows the user to
manipulate, highlight and locate data in the view (e.g. LOCATE, TAG, ALL, CHANGE, SET ZONE, etc.)

LWTOLOG: HMEJ.SELCOPY EMOD] . WTOLOG #

Command [T
loootaonnilonnotfoooo®onontoooc@oooo oono%ooootoonn@ooootooooEaoooFanooToooaio oo oo

QEEDDEE * & % Top of File * * *

HOOODl Program about tTo Start ----- - - - - - - o - o s s s s s oo m s s s s o s s mmmmmmmmmmmmmmm-- - *

BEO0DE About to enter Loop.

EEODDE Exit Loop.

moonDngd FELCOPY --- O CAMCEL "' COMDITIOW MET.

jololofololy SELCDPT REL Z. EE SELECT TIME ERROR ES13 JOE=HEJ 17.13 WED 14 JAaN Zo09

ololninlol ] * % End of File *

Figure 10. SELCOPY WTO Log Window.

Work Area/Current Input Record Window

A Work Area/Current Input Record storage display window is opened automatically when SELCOPY Interactive is started. Further
storage display windows may also be opened via the following:

* Select 'Work area' from the View menu in the SELCOPY Main Menu.
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Executing SELCOPY Work Area/Current Input Record Window
¢ Enter the SELCOPY Interactive CLI command WINDOW WORKAREA.

The current status of the user work area (or input record buffer if no work area is allocated) is displayed in the Work Area window.
A Work area window is a storage display window.

Note that, if WORKLEN is not supplied, the Work Area window has the title: Current Input Record.
Any number of Work Area windows may be opened and each window may be tailored to display different portions of the work area.

The appearance of the Work Area window may be updated using the storage window display options popup menu. The options
available and methods used to display this menu are documented under the CBLi CLI command SHOWPOPUPMENU.

The work area position, in the first row of the Work Area window, is an enterable field (highlighted in red by default.) Here, you may
enter the work area position from which data is to be displayed.

CBLi commands UP CURSOR and DOWN CURSOR may also be used to navigate the Work Area window. By default, UP
CURSOR is assigned to PFO7 and DOWN CURSOR is assigned to PF08.

Data in the work area may be altered at any point during the run by overtyping text in either the character or hexadecimal display. A
change to text in the one display will automatically be reflected in the other.

1 CICZDRECY FOF14odm qoi@cics ESFOFiqm (312
17 dqodogndn ClC4CiFa Fldododm godocics
ST CIFOFzZ4m Jodmdqndm Cic4ciF@ FI4o4md@
49 qEo4acicd CIFOFg4d4m qoimqndm Cicq4CiFm
55 Fododada 4a4acicd CIFQFS4D J04ada40
S1 CicaciFa FP4@d4odm qaodacicd CiFQFS4@
97 qodogndm Cic4ciFm Fadoqndgm gndocicd

113 CIFIF@4D 4@4D4a4n CiC4CiFl Fi409404@
129 qE4@cicd CADICOES 4404040 Cl04CsShs
145 E44nd@dn GE4aC104 CSETIO40 GEGE0GE0G0
161 CIL4CSET DSCIil440 4E4aci0a COETZFOFL B
177 qE4ndE4n CILAC9ES FOFZ4040 4E4@cina
193 COESFOFZS 4@404@040 ClLAC9ES FOF43@4E
209 4E4aC1i09 COESFOFS 4@404040 C1LQC9E:S
ZZ5 FOFE4@40 4E4OCila CIESFOFT G@404@40
241 CIESFEF1 4@0404a4@ 4a4@CilES FOFZ4040 @
257 qEqnd@dn CIESFOFZ 4404040 4E4aciEs
Z73 FOF4d4@40 44034040 CIESFOFS 4@0403040 [OE
259 4@4aCiET FOFS4D4@ 4o40404@0 CIESFOFT
305 qE404E40 4EGACIES FOFS4O40 4E3O3@0GH
Szl CLEGFOF9 fE404040 4E40C1ES FIFOD4040 |8
S37 4E404040 CIESFIFL 4404040 4E4EC1ES
353 FIFZq4040 30404040 CIESFIFS 4@403@40
S69 4O04@aCiET FiF4424@ 40404040 CIESFIFS

Figure 11. SELCOPY Work Area Window.

POS Expression Window

The POS expression window may be opened using the SELCOPY Interactive CLI command WINDOW POS expr. POS expression
windows for special positions POS PARM, DATE, SQLCA, SQLDA and SQLMA may be opened by selecting the "Pos" sub-menu
from the View menu in the SELCOPY Main Menu.

The POS window displays storage in the exactly same way as the Work Area/Current Input Record window with the exception that
the start address of the displayed data is a position in storage evaluated by a valid SELCOPY POS expression instead of position 1
of the work area.

Like the Work Area window, the appearance of the POS expression window may be updated using the storage display window
options popup menu. The options available and methods used to display this menu are documented under the CBLi CLI command
SHOWPOPUPMENU.

The POS expression is re-evaluated at each break in the SELCOPY execution and the data at the new position displayed in the
POS window.

The POS window title contains the POS expression and the evaluated position in the work area in parentheses. If the evaluated
position falls outside the work area, then (Not in WorkArea) is displayed instead.

Any number of POS windows may be opened.

Commands

1 E9CSDRanE ESDECE4D qodmindm Jndodndm kigswpyely
17 G@odogndn fofadndn Godadogsm GG m
ST 44040 Jo4a404a JO4aq4n4E JO4q030
49 qodagndn qod4aq4ngnm godagngnm GoGogngn

55 40dndada 4403040 4O4a4040 JOFO3E30

Figure 12. POS Window (inside work area)
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Executing SELCOPY POS Expression Window

o= ATE LHoT in Workaresh

1 FOF9EIF@ FIciFIF4 40FLIF7TTA FIFZTAFL
17 FO4EFZ4m EESS3495 SSRZ8451 AS4LF1FG
33 ASSSGER1 S195A9451 29aS4Ddn JOFZFOF@
49 FOEIFEF]1 FA4@EEQZ TAFQFZ4D QO@D9E9Z B
ES DOOOFZZE EE9ZVAFD FI4QDDDE DEEDDEHDDEN
Sl DOEODDOEN DDHODDDE DEEHEOEHDDE  DSEEEHAIDE
97 DOEEDEZT RZ19D0I0 DOOEOEHDDE D@01 1400

1153 QEADICTE QZ1600E65 QEODDODED DEOG 1500
129 DOOAIZES DZODODST QDADDED0E DCOSDCODn

Figure 13. POS Window (outside work area)

@ Pointer Window

The @ Pointer window may be opened via the following:

¢ Select '@ Pointers' from the View menu in the SELCOPY Main Menu.
e Enter the SELCOPY Interactive CLI command WINDOW @.

The current status of the @ pointer, LRECL and of all the user @ pointers to be used in the current execution of SELCOPY, is
displayed in the @ Pointer window.

The @ Pointer window has the same characteristics as a CBLi List window including selecting, sorting and filtering of row and
column data and "point and shoot" sorting on column headers.

4 pointers
View Baclkk Forward FLRE Edit Refrash Help
Command:

-Posvalue-- PtrHame Address-
-ETAASL @ jolojoololololo)
18741 EARR mROkS1ESG

4Z LRecCL QRORSTES

Ccal 1 af 28

Figure 14. SELCOPY @ Pointer Window.

Columns Displayed

Name Type Description

PosValue Int Value as a position in the work area
PtrName Char Pointer Name

Address Hex Address in storage of position in work area

Equates Window
The Equates window may be opened via the following:

* Select 'EQUates' from the View menu in the SELCOPY Main Menu.
e Enter the SELCOPY Interactive CLI command WINDOW EQUATES.

All equated names and their values, set by the user via an EQU statement and subsequently allocated by SELCOPY during control
statement analysis, are is displayed in the Equates window.

The Equate window has the same characteristics as a CBLi List window including selecting, sorting and filtering of row and column
data and "point and shoot" sorting on column headers.
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Commands
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Figure 15. SELCOPY EQUates Window.

Columns Displayed

Equates Window

Name Type Description
EQUName Char Equated name
EQUValue Char Equated value
PCB Window

The PCB window may be opened via the following:

* Select 'PCB'

from the View menu in the SELCOPY Main Menu.

e Enter the SELCOPY Interactive CLI command WINDOW PCB.

This window shows the PCB which was used to execute the most recent IMS call

The PCB displayed will change if different PCBs are used in the SELCOPY program.

DFSSAMOS Pch
FCE:» 3 of FrocOpt:
CEDMame: SensSeqg:
Segment Lewal:
Status:
Key Feedback - lermngth =232 (= 0021°]
gRReEE FOFZCIDE FS9FEFGRCZ2 FiFod4o4i 40404040
geeelie JqoFoFR4e CLlClFLIFE FEFLF
gpeooza 40

140 40404040

Figure 16. SELCOPY PCB Window.

TRACE Window

The TRACE window is opened automatically when SELCOPY Interactive is started. It may also be opened via the following:

e Select 'Execution trace' from the View menu in the SELCOPY Main Menu.

e Enter the SELCOPY Interactive CLI command WINDOW TRACE.

The TRACE window is a CBLe edit view that contains all the SELCOPY control statements at which processing has been stopped.

i.e a break point was set and encountered. Each logged statement begins with the statement's selection id.

Note that the STEPINTO and STEPOVER commands dynamically set and unset break points to allow stepping through the
SELCOPY job. The STEPINTO command sets a break point on the next control statement to be executed following the current
control statement. Therefore, when repeatedly issuing STEPINTO or STEPOVER, the TRACE window displays a log of all the

statements executed

so far.

Prior to CBLi release 1.20, this trace information was displayed in the background of the SELCOPY Interactive parent window.
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Executing SELCOPY TRACE Window

CommETd
lewateanalonseteneeZansateneaSannntenestennstenesSanastasaabonantenanaT
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EEEHELE if Barr » marrtmarel-1

EEEEL 1 E. d pd=1 _dsn=inl  dir into Rarr * Directory reco
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EEE01 4 Q. else Barr = RBarp+marre * Mext input posi

ololoiok =} 1@. TtThen 9ota memloop
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QEEEOLT E. rd pdsl _dsn=inl dir into Rarr # Directory reco
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Figure 17. SELCOPY TRACE Window.

Point-and-Shoot Popup Menu

All CBLe type SELCOPY Interactive windows, including the SYSIN/SYSIPT and SYSPRINT/SYSLST windows, support the
point-and-shoot options popup menu. The popup menu is opened using the SDBPOPUP edit macro defined on PF4 by default.

The cursor position within the edited data identifies the focus text to be referenced in items of the point-and-shoot menu when it is
opened.

Ccommandy else Barr = Barr+marre # Mext input po...
Show PoOsS “marre"

-------- "Earr+marre”

-------- "darr+marre" {edit:

Track "marra"

----- "Earr+marre”

----- "Barr+marre" {editr

Track List

Ereak <togaleX

Goto EOT

Window Layout
EditT Keuys

Figure 18. SELCOPY Point-and-Shoot Popup Menu Window.

The menu enables the user to quickly and easily perform the following, commonly used tasks:

CmdText
Execute the CBLe CMDTEXT command against the command string text at the focus position.
Show Pos "expression"
Execute the SELCOPY Interactive CLI command WINDOW POS expr to open a POS storage display window starting at
the position defined by expression. Show POS entries exist for POS expressions determined by the token on which focus
was placed when the menu was opened. Possible expressions are:
1. The focus token that forms part of a larger positional expression.
2. If applicable, the full positional expression containing the focus token.

Show Pos "expression" <edit>
Same as the Show Pos entry but instead of executing the WINDOW POS expr command directly, it is placed at the edit
command prompt ready for edit and submission by the user.

Track "expression"
Invoke the SDBTRACK edit macro which issues the SELCOPY Interactive CLI command TRACK expr to start or stop
tracking a position in storage referenced by the POS expression. Track entries exist for POS expressions determined as
for "Show Pos".

If a Track entry is selected, another popup menu is opened prompting the user to select the colour to be used for tracking
this POS expression or, alternatively, to turn off tracking for this POS expression.

Colour
Elue

Red

Pink
Green
Turquoise
Yel low
White

off

Figure 19. SELCOPY TRACK Colour Popup Menu Window.
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Executing SELCOPY Point-and-Shoot Popup Menu

Track "expression" <edit>
Same as the Track entry but instead the generated "SDBTRACK expression" macro invocation is placed at the edit
command prompt ready for edit and submission by the user.

Track List
Open a popup menu displaying a list of all POS expressions that are being tracked. The user can then select an entry to
switch off tracking for that POS expression or select All to switch off tracking of all the POS expression entries.

ARR green
EARR+MARRE blue
LRECL+Z@ Pink

ALl

Figure 20. SELCOPY TRACK List Popup Window.

Break <toggle>
Toggle a break point on and off for the SELCOPY operation at the focus position.

Window Layout
Invoke the SDBWINX edit macro which opens a popup menu enabling the user to control the configuration of windows
within the SELCOPY Interactive MDI environment.
The user can save and subsequently restore the characteristics of the current MDI child window or all currently open MDI
cﬂi:g wingows. Alternatively, the user can select the default configuration for the current, or all SELCOPY Interactive MDI
child windows.

Default
Restore
Save

Default
Restore
Save

ALl
ALl
ALl

Figure 21. SELCOPY Window Layout Popup Menu.

Edit Keys/Debug Keys
Certain default PFKey assignments for CBLe text edit differ to defaults set up for the SELCOPY Interactive environment.
This entry enables the user to toggle between the CBLe (Edit) default keys and SELCOPY Interactive (Debug) keys as

follow:
PFKey Edit Debug
PF1 SOS LINEADD STEPOVER
PF2 DUPLICATE STEPINTO
PF13 SOS LINEDEL GO
PF14 SPLTJOIN BR ON CURSOR PERM

SELCOPY Interactive Commands

You can issue SELCOPY Interactive commands from the command line at the Command> prompt. Most SELCOPY Interactive
main window menu options have a command line equivalent.

Command Description PF Key
BREAKPOINT Set/unset temporary break points. PF14
EQJ Force SELCOPY End-of-Job. -

GO Continue processing. PF13
RERUN Re-run from the beginning. -
STEPINTO Step (Trace) Into sub-routines. PF2
STEPOVER Step (Trace) Over sub-routines. PF1
TRack Track a SELCOPY POS expression. -
Window Open a specified SELCOPY Interactive window. -

See SELCOPY Interactive Function Keys for complete list of default PFKeys.
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BREAKPOINT
Syntax:

>>-- BReakpoint —-—————-——————————- ><

Description:

Use the BREAKPOINT command to set or unset a permanent BReak point at the focus statement in the Control Card window. By
default, BREAKPOINT is assigned to PFO06.

If a break point is set at a particular control statement, then processing will be paused on the next attempt to execute that
statement.

Any number of concurrent break points may be active during job execution.

Parameters:
BREAKPOINT has no parameters.

Description:
Use the EOJ command to force SELCOPY to immediately execute a "GOTO EOJ" operation.

The SELCOPY job will end without processing any further control statements and will generate its output summary in the
SYSPRINT window.

Parameters:

EOJ has no parameters.

Description:
Use the GO command to continue processing of the control statements. By default, GO is assigned to PF04.

Processing will continue until a break point or End-of-Job is encountered at which point processing is paused or stopped
respectively.

Parameters:

GO has no parameters.
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GO

RERUN

Syntax:

>>-—-+- RErun ——+-———-—-""-"""----———-— ><
+‘— RR ————— ‘+

Description:

Use the RERUN command to Re-Run the job from the beginning. No further statements will be executed from the existing job run.

Storage is cleared and values and break points, set during control statement analysis, are re-initialised. All existing breakpoints are

cleared.

Parameters:

RERUN has no parameters.

STEPINTO

Syntax:

Description:

Use the STEPINTO command to step through the SELCOPY control statements logically one at a time. By default, STEPINTO is

assigned to PF02.

Any branch to a SELCOPY sub-routine via a DO, PERFORM or GOSUB operation will be Stepped Into. i.e. processing is paused

on each control statement in the sub-routine.

STEPINTO and STEPOVER set and then unset temporary break points in the SELCOPY control statements in order to pause

processing.

Parameters:

STEPINTO has no parameters.

STEPOVER

Syntax:

Description:

Use the STEPOVER command to step through the SELCOPY control statements logically one at a time. By default, STEPOVER is

assigned to PFO1.

Any branch to a SELCOPY sub-routine via a DO, PERFORM or GOSUB operation will be Stepped Over. i.e. the sub-routine is
executed and processing is paused again on the control statement following the sub-routine call.

STEPINTO and STEPOVER set and then unset temporary break points in the SELCOPY control statements in order to pause

processing.
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Parameters:

STEPOVER has no parameters.

STEPOVER

TRACK
Syntax:
>>-—— TRack —- expr ———+-—————————————— +-———><
I |
+--— colour —---+
I |
+-——— OFF -—-—— +
Description:

Use the TRACK command to track the value of a valid SELCOPY POS expression as a position in storage.

The single byte, addressed by the POS expression, is highlighted in all open storage windows in which the position is displayed.

The POS expression is re-evaluated for every break in the SELCOPY execution.

Parameters:

expr

A valid SELCOPY POS expression. This may include EQUated names, @ pointers, LRECL special POS keywords (e.g.

DATE, COMREG), integer values and arithmetic operators "+" (plus) and "-" (minus).

colour

The colour in which the evaluated position is highlighted. This is a two character code defining the colour and, optionally

the extended highlighting, to be used.

Valid colour codes are:

Blue

Green

Pink

Red

Turquoise

White

<EFPPo®

Yellow

Valid extended highlighting codes are:

o

Blink

None (No extended highlighting)

Reverse Video

C |0 |Z

Underscore

The default extended highlighting is R (reverse video), the default colour is T (turquoise).

OFF

Switch off tracking for the specified expression.

Examples:

TRACK @A+10 R

Highlight in red (default reverse video) the byte in all storage windows that is referenced by the expression @A+10.

TRACK ARRAY+@X-1

GU

Highlight in green with underscore the byte in all storage windows that is referenced by the expression ARRAY+@X-1.
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WINDOW

Syntax:

>>-— Window ——+--—- @ —————————- +-—><
Jlr——— AT-————————— ‘+
Jlr——— Ctl ———————- J‘r
l——f EQuates ,,77L
l——— List ——————- l
T — :
l——— POS expr ———l
e gt e !
l——— Workarea ———l
e — :
l——— TRace —————-— l

Description:

Use the WINDOW command to open and place focus on the nominated window type.

Windows may also be opened via the Window menu of the SELCOPY Interactive main window menu bar.

Parameters:

@
AT

Open and place focus on the @ Pointer window.

CTL
Open and place focus on the Control Cards window.
Note that, closing the Control Cards window also exits SELCOPY Interactive.
EQUATES
Open and place focus on the Equates window.
LIST
Open and place focus on the Output Listing window.
Note that, closing the Output Listing window also exits SELCOPY Interactive.
PCB
Open the PCB window.
POS expr
Open a POS window. A valid SELCOPY POS expression must be specified to define the start address of the storage
display.
SQL
Open the SQL Log window.
WORKAREA
Open a storage window (Work Area window.)
WTO
Open the WTO Log window.
TRACE

Open and place focus on the Trace window.
Note that, closing the Trace window also exits SELCOPY Interactive.

SELCOPY Interactive Function Keys

You can assign 3270 Program Function Keys (PFKeys) to CBLi and CBLe commands as applicable. The CBLi KEYS command
may be used to display and globally assign Function key settings.
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SELCOPY Interactive Function Keys

SELCOPY Interactive PFKeys have default functions assigned as determined by the window's class (i.e. Edit, Storage or List.) In
addition to these, edit views and storage windows have the following PFKey definitions:

PF1 StepOver

PF2 Steplnto

PF4 Macro SdbPopup
PF5 ShowPopupMenu
PF13 Go

PF14 BreakPoint

Execute the next SELCOPY operation (step over a sub-routine.)

Execute the next SELCOPY operation (step into a sub-routine.)

Invoke the SDBPOPUP edit macro to display a functions menu (edit views only.)
Open the storage display options popup menu (storage display windows only.)
Continue SELCOPY processing.

Toggle a break point on and off at the focus operation (edit views only.)

For edit views only, the default action of the PF1/PF2/PF13/PF14 keys may be governed via the SdbPopup macro which allows the
user to select either "Edit" or "Debug" PFKey configuration.
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Executing CBLVCAT

1. CBLVCAT Interactive Window
2. Raw Data Window

CBLVCAT Interactive Window

The Execute CBLVCAT window is used to execute CBLVCAT Interactive and may be opened via the following:

¢ Select 'Execute CBLVCAT' from the FILE menu item in the CBLi Main Menu bar.

e Enter the CBLi command VCAT on the command line of any window.

¢ Enter the "T" or "VC" prefix command in the prefix area of an existing Execute CBLVCAT window or certain other List type
windows. "T" will generate a CBLVCAT Tune report and IDCAMS DEFINE deck for a VSAM file, "VC" will generate a
CBLVCAT catalog and/or VTOC report for the list entry.

CBLVCAT is used to generate standard and customised reports on VTOC and ICF/VSAM catalog data. It also supports VSAM file
tuning and generation of IDCAMS DEFINE job source.
Details on CBLVCAT output and control statement syntax is found in the CBLVCAT User Manual.

CBLi loads CBLVCAT and assumes control over its control statement input and report output functions. This allows the user to
specify CBLVCAT input statements directly at the VCAT Command prompt or indirectly via a control statement file and view the
output in a window.

In order to direct input from a control statement file, the fileid should be entered at the VCAT Command prompt and prefixed with a
"<" (less than) symbol.

If you are using the LISTVCAT DEFINE option then the generated IDCAMS control statements are displayed in a CBLe text edit
window and may subsequently be saved to a file.

After execution of CBLVCAT control statements (or control statement file), the SYSPRINT (MVS and CMS) or SYSLST (VSE)
output is presented in the display area of the Execute CBLVCAT window.

The Execute CBLVCAT window is essentially a List window with a single column (i.e. SysPrint) and has the same charactersitics

as List windows. For example, the Execute CBLVCAT window supports Prefix Commands and filtering, to display new views of the
data.
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Figure 22. CBLVCAT Interactive in 62x160 3270 Session.
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Executing CBLVCAT CBLVCAT Interactive Window

In addition to the standard List window menu items, the Execute CBLVCAT window includes the menu item RAW to open the
CBLVCAT LISTVCAT or LISTVTOC Raw Data window.

CBLVCAT Log Output window is opened only if the CBLVCAT execution has generated SYSLOG output. This usually occurs if an
error has been encountered in which case an information window is also displayed.

CELYCAT Log Output

“Wiew Back Forward FDE Edit Refresh Help
Command:

———————————————————————————— sSysLog--- - - - - - —-"—-"—-—"—"—"=—"—"—"—"—"—"—"—"—"—"—"—"—"——-—

Figure 23. CBLVCAT Log Output window.

VCAT Command>
Enter one of the following:

¢ A CBLVCAT command, as you would code it on a CBLVCAT control statement.
0 <filename, where filename is the name of a CBLVCAT control statement file.
The CBLVCAT command syntax is described in the CBLVCAT User Manual.

VCAT Program>

Specify the name of the CBLVCAT executable MODULE (MVS) or PHASE (VSE). By default, this field contains CBLV.

Prefix Commands

The following prefix area commands are available:

Command |[Description

(blank) See Note 1 below. (The ENTER key must be pressed with the cursor on the line(s) belonging to the report
entry).

Open the CBLe text editor to to perform SDATA BROWSE on the entry.
Copy the entry.

Delete the entry. User will be prompted to verify the deletion.
Open the CBLe text editor to edit this entry.
Open the FSU - File Search/Update Window to perform advanced file search and optionally update.

T MmO ||O ([0

FO Open an SDE view to display (browse) the entry as output from the FSU - File Search/Update Window.
FS If the entry is a PDS/PDSE, open the file search window for the PDS.
I Open an IDCAMS Command window and issue an IDCAMS LISTCAT for the entry. (default)

Delete (Kill) the entry without prompting for verification.

K
L Open a Dataset List window for the entry.

M If the entry is a PDS/PDSE, open a Library List window.
Q

R

Open a Dataset Enqueue List window for the entry (major name SYSDSN.)

Rename the entry.

SD Open the SDE BROWSE/EDIT Dialog Window to browse or edit the entry's data within a Structured Data
Environment window view.

T Open another Execute CBLVCAT window and issue a LISTVCAT with TUNE DEFINE to generate tuned
output for the entry.

V Open the CBLe text editor to View (edit read/only) this entry.

VC Open another Execute CBLVCAT window and issue a LISTVCAT and/or LISTVTOC operation (as appropriate)

for the entry. See Note 2.

4 Perform a compress of an MVS PDS library to reclaim disk space occupied by replaced (back-level) members.
This action performs an IEBCOPY to itself. No action is taken for PDSE entries, however, the IEBCOPY dialog
is opened with an error message if executed against any non-PDS(E) entry.

? Open the volume statistics window for the volume containing the entry.
Note that this command will only be successful for lines of a LISTVCAT report containing VOLn=volser.

> Open a new window containing a zoomed vertical display of the entry's fields. Particularly useful for list
windows that have a large number of displayed columns.
Assigned to PF2 by default.

2009/07/20 16:03:29 CBL Interactive (CBLi) 32



Executing CBLVCAT CBLVCAT Interactive Window
Notes:

1. The default action on hitting <Enter> on a SysPrint line depends on the contents of the report entry, as follows:
1. If the entry contains the TYPE field "USERCAT" or "ALIAS OF", then prefix command "VC" is default.
2. If the entry contains the TYPE field "PDS" or "PDSE", then prefix command "M" (Member List) is default.
3. If the entry contains a fileid, then prefix command "E" (Edit) is default.

2. The "VC" prefix command performs LISTVCAT/VTOC operations based on the contents of the entry fields, as follow:
1. If the entry contains the TYPE field "USERCAT", then a new report is generated for the entire contents of that
catalog. Otherwise, only list the catalog entries that match the fileid.
2. If the report entry also contains a "VOLn=volser" field, then generate a LISTVTOC report for entries that match
the fileid in the volume's VTOC.

Columns Displayed

Name Type Description
SysPrint Char VCAT output report line

Raw Data Window

The CBLVCAT Raw window may be opened via the following:

¢ Select 'Raw' from the menu item of the Execute CBLVCAT window.
e Enter the CBLi command LVR on the command line of any window.

Where CBLVCAT arranges data in a printable report format, the CBLV Raw Data window provides a list of all report field data
accumulated by CBLVCAT in order to generate the report.

The CBLVCAT Raw window has the same characteristics as a CBLi List window including selecting, sorting and filtering of row and
column data and "point and shoot" sorting on column headers.

CELWCAT Raw:

Li=twcat Kk .—-|_|—|-||:|

CommandX>
WCAT Command: listwcocat key=nbj tupe=c
¥
—————————————— csH--------------"--T¥PE-- --MRECS--- --PCHT-- -ALLOCT- ALLOCU
_ HMBJ.CELIDEMO.HKSDHE KEDE a2 EE. O c==2
_ I =2 25. 0 1
__ HBJ.CELICDEMO.WOOOA.HKSDS KSDS (R I=Holc] El. 3 =24
_ I 35 71.5 1
__ HMBJ.CELICDEMO.WOOOGO.HKSDS KEDE I=Hopc] 24. 9 84
_ I 13 29.4 1
___ HBJI.CELICDEMO.WOOOGE.KSDS. TUHED EEDE =g olc] gz2.4 cC==z
Ik = 9.1 1
___ HMBJ.CELIDEMO.WOOO1.KSDS KEDS 4001 El. &8 C=1%8
_ Ik 119 ¥a. =2 2
___ HMBJ.CELIDEMO.WOOO9.KSDS KEDS ES3T 1.4 C=1%8
. I 119 E7.E 1
___ HMBJ.CELICDEMO.WOO10.KSDS KEEDE 250 27. 0 C=&
. I E 18. =2 1
___ HMBJI.CELITEST.HKSDHES KEEDE = 2.4 1
. I 1 2.1 1
___ HWBI.DLDIR KSDSR) 44 b.7 C=2=
. I =2 25. 0 1
__ HWBJ.FSU.DZ200823225.T113225.0UTRFPUT ESDS 1032 25. 0 1
___ MBJ.FSU.TEST.ESDES ESDS(R) 16 4., 2 2
__ HMBJ.FEU.TEST.HKESDE KEDE a2 2z2.0 1a
_ I 1n 260 . 5 1
___ HMBJ.FSU.TEST.HKSDSZ2 KSDS(R) =p e #k 99, Tk 24
_ I 25 TE. & 1
___ HMBJI.HKSLE KSDS(R) 1 .2 1
_ I 1 2.1 1
___ HMBJ.SELCOPY.DEWMO.HKESDES KSDS (R ol B3E] 1
I 1
___ HMBI.TEST.RKSDES KSDS (R E 1.3 i
_ Ik 1 2.1 1
___ HBJIZ.LDDIR KSDS (R EES4 Ta2.5 C=3
_ Ik 4 Zz.4 1
___ HMBJIZ.DEW.FSU.DZOOE232432.T15312E5 ESDSLR) =3 1.7 1
___ HMBJIZ.DEVW.FSU.DZOGOS23242.Tilelz202 ESDSLR) 26 2.4 1
___ HMBJIZ.DEVW.FSU.DZOGOE23242.T17471E ESDSR] =z 2.4 1
HMEJZ2.DEY.FSU.DZ20083244. T11100%8 ESDS R == 1.7 1
F =R 7 2 Wl 1 = sort DEHM

Figure 24. CBLVCAT LISTVCAT Raw Data Window.
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Figure 25. CBLVCAT LISTVTOC Raw Data Window.

Prefix Line Commands

The following prefix line commands are available:

uol=cblmiE

“Wiew Back Forward FDEB Edit Refresh Help
WCAT Commandr listwtoc wol=cblmits
b
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153 00 153214
FIeg- 00 29314
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101800 101814
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149404 1494701
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149405 149405

149404 1494049

1 A2 149402

1 Soe 1

1 Soe 1

1 S0E 1
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B
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Command Description

(blank) (Hit <Enter> with the cursor on a particular entry line).
Prefix line command "M" if entry is a PDS/PDSE library, prefix line command "E" otherwise.

B Open the CBLe text editor to to perform SDATA BROWSE on the entry.

D Delete the entry. User will be prompted to verify the deletion.

E Open the CBLe text editor to edit this entry. (Default for non-PDS/PDSE entries)

F Open the FSU - File Search/Update Window to perform an advanced search and optionally update the
contents of the entry.

FO Open an SDE view to display (browse) the entry as FSU - File Search/Update Window output.

FS Open the File Search window for the entry.

I Open an IDCAMS Command window and issue an IDCAMS LISTCAT for the entry.

K Delete (Kill) the entry without prompting for verification.

M If the entry is a PDS/PDSE, open a Library List window. (Default for PDS/PDSE entries)

Q List dataset enqueues (major name SYSDSN) for this entry.

R Rename the entry.

SD Open the SDE BROWSE/EDIT Dialog Window to browse or edit the entry's data within a Structured
Data Environment window view.

T Open an Execute CBLVCAT window and issue a LISTVCAT TUNE DEFINE operation for the entry.

uT 8&6;??'the general file utilities menu to ultimately generate specific line commands in a temporary

ile.
V Open the CBLe text editor to View (edit read/only) this entry.
VC Open an Execute CBLVCAT window and issue a LISTVCAT operation for the entry.
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Executing CBLVCAT Raw Data Window

4 Perform a compress of an MVS PDS library to reclaim disk space occupied by replaced (back-level)
members. This action performs an IEBCOPY to itself. No action is taken for PDSE entries, however,
the IEBCOPY dialog is opened with an error message if executed against any non-PDS(E) entry.

/ Open a drop down menu containing valid prefix command functions for the list window entry. Position
the cursor on the required function and hit <Enter> to action the command.
Assigned to PF4 by default.

> Open a new window containing a zoomed vertical display of the entry's fields. Particularly useful for list
windows that have a large number of displayed columns.
Assigned to PF2 by default.

Columns Displayed
For LISTVTOC Output, the data displayed is:

Name Type [Description
DSN Char Daia Set Name
CYL/HD Char Low and high Cvlinder/Head Limits
CISIZE Char Control Interval Size
START Char Relative track/block start address
LLOC Char Number of allocated tracks/blocks
USED Char Number of used tracks/blocks
TYPE Char Data set type
EXPIRES Char Expiry date
BLKSIZE Char Blocksize
LRECL Char Logical Record Lenath
RECEM Char Record Format
CREATED Char Creation date
INFO Char Informational messages
VOLUME Char VTOC volume id
CCESSED Char Last Accessed date
UNIT Char Unit (cuu) of DASD volume

For LISTVCAT Output, the data displayed is:

Name Type IDescription
DSN Char Data Set Name
TYPE Char Data set type
NRECS Char Number of records
PCNT Char Percent of allocated space used
LLOCT Char Total allocated tracks/blocks
LLocy Char Unused allocated tracks/blocks
LLOCP Char Defined Primary allocation (tracks/blocks)
LLOCS Char Defined Secondary allocation (fracks/blocks)
ERSP Char Defined Free Space per Cl and CA
LMAX Char Defined Maximum Becord Lenath
KL/BLK/IMB Char Duplicate of fields KL .BKP or BLKSIZE or IMB/REP.
CISIZE Char Control Interval Size
BUFSP/IXL Char Duplicate of fields BUFSP or IXL
EXCPS Char Number of EXecuted Channel Programs
TIMESTMP. Char Timestamp that file was last closed
NSEC Char Number of secondary extents
VRBL Char Defined average BECORDSIZE
PHYREC Char Physical Record Size
RECSTATS Char Records deleted, inserted, updated and read
KL Char Defined KEYS Lenath
RKP Char Defined KEYS Position
BLKSIZE Char Block size (VSE/NSAM SAM)
IMB/REP. Char IMBED and/or REPLICATE flags
BUFSP Char Defined BUFFERSPACE.
IXL Char Number of Index Levels
Cl/CA Char Number of Control Intervals per Control Area
SHR Char Defined SHAREOPTIONS (local and cross system)
S/C Char Defined SHAREOPTIONS (local only) and USECLASS (primary only)
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DEFINED Char Date on which file was defined
EXPIRES Char Date on which file expires
SPLITCI Char Number of Control Interval splits
SPLITCA Char Number of Control Area splits
SEVL Char Highest CBLVCAT severity message level
VOLUME Char Catalog Volume

GMAX Char GDG Maximum Level

GVER Char GDG Version number

GGEN Char GDG Generation number

STD1 Char Reserved (blank)

STD2 Char Reserved (blank)

HIUSERBA Char High Used Relative Bvie Address
HIALLBBA Char High Allocated Relative Byte Address
FREEBYTES Char Number of unused allocated bytes
COMPONENT Char DATA or INDEX component DSN
ENTRY Char VSAM CLUSTER enfry DSN
SMSS Char Defined SMS Storage Class
SMSD Char Defined SMS Data Class

SMSM Char Defined SMS Management Class
EXT Char Extended Aftributes

CATALOG Char Catalog DSN
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DB2 Dynamic SQL

The DB2 Dynamic SQL window may be opened via the following:

¢ Select 'DB2 Dynamic SQL' from the File menu in the CBLi Main Menu.
¢ Enter the CBLi command SQL on the command line of any window.

DB2 Dynamic SQL window may be used to submit SQL commands to a DB2 database and display the resultant messages and
table views.

The DB2 Dynamic SQL capability is available only to MVS sites where SELCOPY is installed.

The SELCOPY DB2 interface, SELCOPQL load module is used to pass SQL statements to the DB2 data base and so must also
be available in the SELCOPY load library.

On startup, the Dynamic SQL window connects the user to the DB2 subsystem using the DB2 subsystem name and plan specified
in the CBLNAME load module.

The Dynamic SQL window has the same characteristics as a CBLi List window including selecting, sorting and filtering of row and
column data and "point and shoot" sorting on column headers.

CELe - Dymnamic SOL: DESG
“Wiew Back Forward FDE Edit Refresh Log Help

]
CommandX>
DEZ Sub=ystem> DE9G Flanmn> CELFLAMD
Select Limit> 200 AutaCommit> %

SQOL Statement> SELECT #* FROM SYSIBM. SYSCOLUMMS WHERE COLTYFPE='CHAR®Y ORLCER BY

* MAME

*

*

——————— HAaME------- - - - -=------TBMAME---------- TEBCEEATOR COLWMO- COLTYPE- LEHG
___ ACCESSFPATH SYSPACKSTHMT SYESIBEM 14 CHAR
___ ACCESSFPATH SYEETHT SYESIBEM 11 CHAR
___ ACCESSFPATH SYSPACKSTHMT SYESIBMY 14 CHAR
___ ACCESSFPATH SYEETHT SYESIBMY 11 CHAR
____ ACCESSTYFE FLAM_TRELE SYSIBEM 13 CHAR
__ HACCESSTWYFRPE FLAM_TAELE DEZOSC 10 CHAR
__ HACCESSTWYFRPE FLAM_TAELE DEHE31 0 10 CHAR
__ HACCESSTWYFRPE FLAM_TAELE CLAREG 10 CHAR
_ ACCOUNTIMG DEZ_THREAD_STATUS 5SS 1 EM 19 CHAR 2
__ RACCTHO SUFFLIER (] 1 CHAR
____ RACQUIRE S ESFPLARM S%'S1EBEM 12 CHAR
____ RACQUIRE S ESFPLARM S%'ES1BMW 12 CHAR
_ RACTION TORTYAL DEME391 @ 2 CHAR
_ RACTION WOPTYAL DEXME91 0 2 CHAR
_ ACTIOM_IMD ADBCHE IBEMUSER 2 CHAR
__ ACTIWE SYSROUTIMES SYSIEBEM 90 CHAR
__ ACTIWE ODEBZ THREAD_STATUS SYSIEBEM E CHAR
__ ACTIWE SYSREOUTIMES SYESIBMY 91 CHAR
_ ACTHEWD EACT OEHE910 2 CHAR
_ ACTHEWD ACT OEHE910 2 CHAR
_ ACTHEWD WACT OEHE910 2 CHAR
___ ADDED_FRED LEM_FREDICAT_TAELE SYESIBEM 2B CHAR
___ ADDED_FRED OEM_FPREDICAT_TAELE DEZOSC B0 CHAR
__ ADMEDEFRT CEFT OESHE910 4 CHAR
__ ADMEDEFRT WDEPRPT OESHE910 4 CHAR
__ ADMEDEFRT WHDEPT OESHE910 4 CHAR
_ ADMRERDEFRT WDEPMGL OESHE910 ¥ CHAR
__ ADMRDEFT EDEFT DEHE31 0 4 CHAR
__ ADMRDEFT HEWDEFT DEHE31 0 4 CHAR
__ ADMRDEFT DEFT FHMDEZ 4 CHAR
__ ADMRDEFT WDEFRT FHMDEZ 4 CHAR
ADMRBEDEFT WHDEFRT FHMHDEZ 4 CHAR
z f 462 | Wiews 1 | =select

Figure 26. DB2 Dynamic SQL window.

DB2 Subsystem>
Specify the DB2 sub-system name to be the target of the CONNECT.
Changing the Subsystem name will cause CBLi to disconnect the user from the current subsystem and reconnect to the
new subsystem.

Default is that defined by the CBLIINI option, DB2.SSN, otherwise the sub-system name specified in the DB2SubSys field
of the CBLNAME load module is used.

Specify the SELCOPY (SELCOPQL) DB2 plan name which has been bound to the DB2 sub-system.
This is the name assigned to the SELCOPY plan during the BIND to the DB2 subsystem.

Plan>

Default is that defined by the CBLIiINI option, DB2.Plan, otherwise the plan name specified in the DB2PIan field of the
CBLNAME load module is used.

Select Limit>

Limit the number of rows to be displayed in the Dynamic SQL window following a SELECT transaction. Once the limit
threshold has been reached, a pop-up message window is displayed and no further attempt is made to retrieve selected
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rows of data.
The n_rows value is placed in the "Select Limit>" field of the Dynamic SQL window.
The default limit is that defined by the CBLIINI option, DB2.SelectLimit, otherwise no limit is implied.

AutoCommit>
Determine whether a COMMIT is to be automatically issued following every transaction (AutoCommit). If COMMIT=NO,
then the user should issue COMMIT manually to commit any changes made to the data. A commit is executed
automatically when the Dynamic SQL window is closed, regardless of the AutoCommit field setting.
The commit value is reflected in the "AutoCommit>" field of the Dynamic SQL window.
The default is YES.

SQL Statement>
Specify valid SQL syntax to be executed.
The resulting data or messages are displayed in the window display area.

The contents of the display area may be edited in a new file using the CBLe text editor by selecting Edit from the window menu.

Select Log from the window menu to open the SQL Log output which displays the daignosis information and SQL return codes
passed from the DB2 sub-system.

m Y1=w Back Forward FDE Edit REefresh Help
Command?

1 ##%% LCEBL Dymamic S0OL Interface Yersion %Ili.1.0 ##*=*

CELSAi0] 17:032:3228 CBL Dymamic S0L Interface i=s= s=tarted. Date: ZO009-0Z2-03

CELS@ARI 1F:03:38 (Sel 0) Connected to DEZ Yersion 9.1.0
Sub=sy=tem: DEB9G Flam: CELFLAMO
UseriMEBJ Current SOQLID: HEJ

CELSAO4I 17:03:38% (Sel 1) OFPEN SELECT cursor SOQLOGOGOOI1

SELECT =

FROM S%SITEM. S¥SCOLUMMNE
WHERE COLTYFE='CHAR'
ORDER EBEY% HMAKNE

CELS@AEI 17F:@2:42 (Sel 1) CLOSE SELECT cursor SOQLOOOOIL
Mote! Emnd of SELECT mot reached.

Frepars ODEZ CFRU= QEUILEE. 1047391 =econds.
OFEM OEZ CFRU= OQEOREEZ. 490252 =econd=s.
Fows Fetchaed=zoo OEZ CFRU= QEURoEgE. 28282559 =seconds.
Total DEBZ CFRU= QUEOLEZ. 8FEELDZ =s=econds.
CELSOATI 17:03:42 (Sel 2) EXECUTE COmMMIT S0L Code=0o
CEZ CFRU= QEUEILEE . 0817Vl =s=econds.

parameters

Figure 27. DB2 Dynamic SQL LOG window.

Select FDB from the window menu to open the Field Descriptor Block which provides detailed information on each field displayed
by an SQL SELECT statement.
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CREATEDTS
DATRTYFEID
DCEFRULT
DEFRULTYALUE
FLOFROLC
FOREI GMEEY
HIDDEM
HIGHZKE"Y
IEMREQD

WMnMmIDDTDEZZr
HoommMmoC IO
T Eroaor e
HHdaroo-d-4drmra

ST TIME
TECREARTOR
TEMAKMME

T FEMAME
TwYFESCHEMA
UFDATES

Figure 28. DB2 SQL FDB Window.

--Type--
Char
Imt
Imt
Float
Imt
Char
Char
Char
Imt
Char
WChar
Char
Char
Char
WChar
Char
Imt
WChar
Imt
Imt
WChar
WChar
Char
Imt
Char
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Executing IDCAMS

The IDCAMS Command window may be opened via the following:

¢ Select 'Execute IDCAMS' from the File menu in the CBLi Main Menu.
¢ Enter the CBLi command AMS on the command line of any window.
¢ Enter the CBLi prefix command "I" where supported by a List type window.

The IDCAMS Command window allows the user to enter any IDCAMS command and view the output in the the window display

area.
The IDCAMS Command window is essentially a List window and has the same charactersitics as List windows. For example
filtering is supported to display new views of the data.

IDCAMS LISTCAT ALL ERNTRY (CEL.CELI.MERLIST
Wiew Back Forward FDE Edit Refresh Help

Command:

[ |
CommandX
AaMSCommand> LISTCAT ALL ENMTRY(CEL.CELI.MERLIST.HKSDS. CHE)
>

I e e Line-—-—-—-—------
1 IDCAMS SYSTEM SERVICES TIME
. @m MARGIMS (1 ZFZ7E0)
— @ IDCEEE1] FUMCTIOM COMPLETED., HIGHEST COMDITIONM CODE LWAS @

z]
— LISTCAT ALL ENTRY(CEL.CELI.MEBRLIST.HKSDS. CMRE)
— @ CLUSTER ------- CEL.CELI.MERLIST.KEDS. CHMP
— IM-CAT --- USERCAT.CEBLCAT
— HISTORY
— CATASET-OWMER-- - - - [MULL) CREATIOM---—---—-- FEBE. 255
— RELERSE--—-—---—-——-—-————— - EXPIRATIOM------ QEEA.BAA
- SMSDATHA
- STORAGECLASS ----CELCFLT MAMAGEMENTCLASS--CELDFLT
- CATACLASS ------ CEL=ACHP LEACKUP ---Q00A@Q0,000, 0000
- EWODO STATUS------ OROQEEA EWO TIMESTAMP---EQ00A0 O0:Q00:008.0
- BWO--------——--—-— - - CHULLY
- FLSCATA
- LOG —-—-——---—-————-——- CHULLD RECOWERY REQUIRED --(HO) FRLOG -
- YSAkM QUIESCED ------- (HO) FLS IM USE - -------- [HO)
@ LOGSTREAMID-——————————— ——— — = — — — — — — — — — — — — — CHULL)
- RECOWERY TIMESTAMP LOCAL----- ¥ OOEOAOOAAOOARARE ¢
- RECOWERY TIMESTAMP GMT---—---- ¥ ' OOEOARORAEOOARAAE
- FROTECTIOM-FPSWD----- CHULL) RACF--—--—--—--—-—-——--———- (MO
- ASSOCIATIONS
- DATA----- CEL.CELI.MBERLIST.KSDS. CMP.DATA
— IMDE¥X----CBEL.CELI.MEBRLIST.KSDE. CMP. IMDEX
— @ cATA —-—-—---- CEL.CELI.MERLIST.KEDS. CMP.DATA
— IM-CAT --- USERCAT.CELCAT
— HISTORY
— CATASET-OWMER-- - - - [MULL) CREATIOM---—---—-- FEBE. 255
— RELERSE--—-—-—-—-—-——-—-————— - 2 EXPIRATIOM------ QEEA.BAR
— e e B o CHULL)
— PROTECTIOM-PSWD----- [MULL) RACF-—--——-———=—-—————— - [MO)
— ASSOCIATIOMS
- CLUSTER--CEL.CELI.MEBRLIST.KSDS. CMP
- ATTRIBUTES

KEYLEN-—-—--—-—-—-———-————— 15 AVGLRECL--——----——-—-————— 255 EUFSFAC
[ 1 E g W 1 | =e=lect +

Figure 29. IDCAMS Command window.

AMSCommand>

Specify valid IDCAMS command syntax.

Prefix Commands

No prefix line commands are supported for IDCAMS Command windows.

Columns Displayed

Asa Char ASA print control character

Line Char Print line
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New File Definition

New files may be defined to the system from within the CBLi environment. Non-VSAM files and most commonly used VSAM
elements can be defined by selecting the appropriate entry from the 'File' menu of the CBLi main window menu bar.

o Allocate NonVSAM
¢ Define KSDS

¢ Define ESDS

¢ Define RRDS

¢ Define LDS

e Define AIX

e Define Path

¢ Define Alias

¢ Define Catalog

Each selection opens a window containing enterable file characteristic fields.

Allocate NonVSAM
Note: Not yet implemented for CMS and VSE.

The Allocate nonVSAM window allows the user to supply the characteristics of the new data set prior to its allocation. Select Define
from the menu to action the allocation and optionally populate the data set.

CBLe text editor also opens the Allocate nonVSAM window when attempting to save a file with a data set name that has not yet
been allocated.

nonS Ak
Define Help
Lataset: HMEJ.DIRCMD.DZO00901&5.T180E6323, ChX

Mode 1
Wo lume
Unit> S%SaALLDA

Tuper SE0 [SEQ|PDS|FPDSE)
Allocation Unitr» TRACKS Organisation: Datar
Frimarygs> 1 FRecord Formati: YWE Storager
Secondarygr 1 Fecord Length: &0 Management
Directory Blocks> 0O Elock=size: 0o
Help
Figure 30. Allocate nonVSAM window.
The Allocate NonVSAM window has the following menu items:
Define This is a popup menu containing the following items:
Foreground Applicable to operation under TSO and CMS. Allocate the data set in the foreground
(Control is temporarily passed to TSO or CMS).
Foreground+COPY As for Foreground but also copy data from the data set specified in the Model field.
Not yet supported.
Background Applicable to operation on VSE and MVS. A CBLe view is opened to edit a temporary

job containing batch JCL to allocate/define the data set. The job may be submitted to
the batch system using the CBLe command SUB.
Not yet supported.

Background+COPY As for Background but also include JCL to populate the data set with data from the

data set specified in the Model field.
Not yet supported.

Help Open the help window for data set allocation.

Define VSAM Elements

Note: Not yet implemented for CMS and VSE.
Define AlX, Path, Alias and Catalog are not yet supported.
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New File Definition

Define VSAM Elements

The Define VSAM windows provide a method of defining VSAM objects simply by entering the required options in the appropriate
fields of a form. Each Define VSAM window contains fields relevant to the object being defined.

The Models field allows the user to model the new object's values on an existing VSAM data set. On entering a VSAM data set

name in the Model field and hitting <Enter>, all other fields are updated automatically to reflect the inherited values.

Select the appropriate Define VSAM Menu bar item to to process the form.

CBLe text editor also opens the Defin VSAM window when attempting to save a VSAM file with a data set name that has not yet

been defined.

Bofe LT van e HELp
5

Mame> CBL.SELCOPY.DEMO1l.HKSDE Tupe: KSDS
Modealx Reusax i
Catalogx Span: I
Spesd: '
Avg rec Lleni 7O Key lLength> & Writecheck: '
Max rec len> 100 Key offset: 0O Erasel !
BEuffer =size: Frese =pacesCI: @O
Expiryg> Frese =pacesCARAX O 5MS Data Clas=s:
FRegiomn share option> 1 SMS Stor Class: CELDFLT
System share option> 2 SMS Mgmt Clas=s: CELDFLT
nmamer CBL.SELCOPY.DEMOL.KSDE.DATA
YMolumes: CELMB4 Ordered: |
Space type: TRACES Frimarygr 1 Secondaryg? i
CI Si=zer 4095
mame> CBL.SELCOPY.DEMOL.KSDE. INDEX
Yolumes: CELMMO4 Ordered: |
Space tupe: TRACKS Frimaryg: 1 Secondary’ 1
CI Si1zex 512 Imbed: M FReplicateXx &l
Figure 31. Define VSAM KSDS window.
All Define VSAM windows have the following menu items:
Define Start the VSAM object definition. (Foreground)
Job Creates and edits the IDCAMS DEFINE statement including job control ready for submission to batch (See
CBLe command SUBMIT.) (Background)
AMS Creates and edits the IDCAMS DEFINE statement only.
Help Open the help window for VSAM elements definition.
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Execute POWER

The POWER Command Output window may be opened via the following:

e Select 'Execute POWER' from the FILE menu in the CBLi Main Menu.
e Enter the CBLi command POWER on the command line of any window.

The POWER Command Output window allows the user to enter VSE POWER commands and view the output in the window
display area.

If CBLIINI variables System.VSESMLogon=No (i.e. no Security Manager is active) and System.TrustedUser=No, then POWER
commands are restricted to PDISPLAY operations only.

The POWER Command Output window is essentially a List window and has the same characteristics as List windows. For example
select, sort and filter to display new views of the data are supported.

FOWER Caoammand Out o
Wiew Back Forward FDE
Command?

Edi+t Refresh Help

FOWER Command: D LST

JobMame- Mumber Sf=x 0 Sys Pr Dis=p CL Cards -FPg- Cc --Form-- ---To--- --Froaom
EASEREST v o L = H A 150 v i SYEA SY'5A
CATYTAM 151 o L = H A 24 4 i SYEA SY'5A
CELCATL TEE o L = H A = 1 i SYEA SY'5A
CELCATL TET o L &) H A =R = 1 S%EA S 5A
CELCATL TEE o L &) H A &) 1 1 S%EA S 5A
CELDEFS TEE o L &) H A 11 &) 1 S%EA S 5A
CELIYTAM 2113 o L &) H A 135 z 1 S%EA S 5A
CELIYTAM == o L &) H A 13 z i SYEA S 5A
CELLIMK TE3 o L B H A T15 27 1 SY SR SY5A
CELLOALD 210 o L B H A 2381 28 1 SY SR SY5A
CELMAMERA 203 o L B H A i3 21 1 SY SR SY5A
CELYWY JOT 215 o L B H A 104 ) 1 SY SR SY5A
CEEWARLC 1177 o L B C A 11 z 1 SY5A
CICSICCF Sz o L £l H A 217 1@ 1 SYERA SYEA
CICSICCF 1@19 o L £l H A Il g 1@ 1 SYERA SYEA
CICSICCF 13328 o L £l H A 249 11 1 SYERA SYEA
CICSICCF 1857 o L £l H A 2178 ch] 1 SYERA SYEA
CICSICCF 1112 o L £l H A ZEQ@ 3 1 SYERA SYEA
CICSICCF 11182 oL = H ] Z2EQ 3 1 SH SR S S8
= 1 = C 1 I E = * = ar

Figure 32. POWER Command Output window for PDISPLAY LST.

POWER Command>
Specify the VSE POWER command. Note that POWER commands relating to cross partition usage (e.g. PDISPLAY
STATUS) are not supported.

Prefix Commands

The following prefix line commands are supported for PDISPLAY (RDR, LST or PUN) output only:

Command

Description

(blank)

Prefix Line command E. (The ENTER key must be pressed with the cursor on the line containing the required
entry).

D

Delete the entry. User will be prompted to verify the deletion.

E

Open the CBLe text editor to edit this entry.
If an entry is password protected, then it may be edited by any user so long as the password is supplied. A
pop-up window will prompt the user for the password.

Non-password protected entries may only be edited if either of the following are true:

e System.TrustedUser=Yes in the CBLIINI file.

¢ System.VSESMLogon=Yes in the CBLIINI file and the TO or FROM attributes match the current
user's userid.
Note tha